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Introduction to Release Notes for 10.97.1 Critical Fixes
Rollup 3

This edition of Release Notes documents the changes made for 10.97.1 Critical Fixes
Rollup 3. It includes both fixes and enhancements.

Note that 10.97.1 Critical Fixes Rollups are not compatible with other 10.97.x products,
such as 10.97 or 10.97.2.

"First Available In" Column

Rollups are cumulative. Each rollup contains the fixes and enhancements of the previous
rollup, so only the latest rollup is required to bring a system up to date. Rollups can be
installed on top of a prior rollup or onto a system with no rollups.

The "First Available In" column notes which rollup a fix or enhancement first appeared in
so that users who already have a rollup can determine what items are new for them.

Security Vulnerabilities
Information about security vulnerabilities may not be found in this document. For this
information, refer to iconics.com/cert.



https://iconics.com/cert

Common & Platform Services

Ref ID Description
Resolved a rare deadlock on the Web Socket communication layer. This deadlock could cause

89185 services (such as FrameWorX, GridWorX/Databases, or AnalytiX-Bl) to stop communicating or
leak memory.

90086

90088

90089

90090

90091

90092 . . .

90314 Various enhancements to improve the security of the software.

90087

89588

89733

90452

89591
Added a new Control and Diagnostics point, :ClientlPAddress. This point shows the IP address
of the client. It works with both WPF and HTMLS5 clients.

87666 . . . L e .

88551 Note, ICONICS highly recommends against using this point to secure any sensitive information
or functionality, as it may be possible for a client application to override this value or for the
system to spoof the IP address. As a best practice, security should be implemented on the
server side using the ICONICS security server.

88155 The About Box now shows the Critical Fix Rollup version instead of just "10.97.1".
Resolved a crash in certain applications that could occur when the application read a data point

88783 that did not start with the @ symbol and was of type TimeSpan. The crashing applications
included AlarmWorX64 Server, Unified Data Manager, DataSpy, and AlarmWorX64 Multimedia.
These documents from the original 10.97.1 installation media have been updated. The updated
copies can be found in the "Updated 10.97.1 Documents" folder.

86914 N . . _—

86950 ICONICS - Compatible S(?ftware and Operétln.g Systems.pdf (application note)
* Hyper Alarm Server - Quick Start.pdf (application note)
* |CONICS-Suite-Resolved-Issues-10971.pdf
* ICONICS-Suite-Whats-New-10971.pdf

Commanding

Ref ID Description
When using the Edit Pen command, the HTML5 TrendWorX64 Viewer did could not find the

87635 . .
pen by name, only by index. This has been resolved.
GraphWorX64 local aliases cannot be used directly inside batch commands, so to address this
need, batch commands now have a new property called Parameters. This property can be found
in the CommandParameters section of a pick action when the Command is set to "Batch".
The Parameters property can be used to initialize static variables inside the batch command.
These variables can be used to pass in local alias values or other bits of information that might
normally not be accessible inside the command.

87368

The Parameters property itself must be a string that defines the static variable and its value. The
syntax used is similar to that used to set global aliases. An expression can be used to build this
string using dynamic values. Below are two examples of the Parameters property:

myStatVar=1;anotherVar=5;

{{x="myStatVar="+"<<localAlias>>"+";"}}

First Available In

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 1

First Available In
Critical Fixes
Rollup 2

Critical Fixes
Rollup 1



Ref ID

Description
Once a static variable is defined using the Parameters property, it can be used within the batch
command using syntax similar to local aliases: < <myStatVar>>

These variables cannot be changed inside the batch command. They are set once when the
batch command is triggered and will retain that value for the entire run of the command.

Note, there is a known issue that the Parameters field appears inside the configuration dialog
for the batch steps. It should not appear here, and values entered into this field will not be
saved. This will be addressed in future versions. For now, users should make sure to use the
Parameters field in the GraphWorX64 Dynamics panel under CommandParameters and ignore
the Parameters field in the steps configuration dialog.

Data Browser

Ref ID
87809

88278

87426

Description

Resolved an issue causing Global Aliases to be missing under the Platform Services tree in the
data browser.

Resolved an issue in the Data Browser that appeared in 10.97.1 Critical Fixes Rollup 1 which
would cause applications such as GraphWorX64 or Workbench to hang in task manager after
they were closed if the pop-up Data Browser had been used.

When running in AssetWorX Tag Counting mode (used in GENESIS64 Basic SCADA), the proper
set of browsable tags may not have been shown when switching back and forth between an
area of Workbench that was allowed to browse the entire address space (like AssetWorX
equipment properties) and an area that was only allowed to browse a limited set of the address
space. The browser could behave as if the user were still using the previous client (so
attempting to browse for tags from inside Hyper Alarm Server might have incorrectly shown
the entire address space if the user previously was browsing for tags under an AssetWorX
equipment property). This has been resolved.

FrameWorX

Ref ID

89277
89302

89550

89743

90085

87543

87274

Description

Resolved connection issues with FrameWorX node pairs that had auto-failback disabled. Issues
might include nodes incorrectly showing as offline in MonitorWorX Viewer or failure to get data
via the FrameWorX alias.

On a system using reverse networking (configured in Platform Services Configuration > Basic
tab > Reporting section) and a FrameWorX node pair or server alias (configured under
Workbench > Platform Services > FrameWorX > FrameWorX Network, tags using the server
name defined in FrameWorX Network could stop showing data and have a status/quality of
"Bad — Communication Error". This has been resolved.

Resolved a rare crash (System.InvalidOperationException) of ICONICS FrameWorX and ICONICS
Simulator Point Manager services on startup.

When using a reporting server (configured in Platform Services Configuration > Basic tab >
Reporting section), if the reporting server went offline, tag handles might not be properly
deleted, leading to warnings in the FrameWorX Server TraceWorX log and a memory leak in
FrameWorX Server. This has been resolved.

Resolved a rare license failure that could occur due to extra newlines in the
FwxServer.Network.config file inside empty attributes. These newlines could also have caused
custom GenEvent messages defined in FwxServer.Network.config to appear blank in runtime.
The newlines may still appear, but no longer cause any issues.

OPC UA servers configured under Data Connectivity > OPC UA > OPC UA Network were not
browsable if they were configured with a Secondary Endpoint URI. This has been resolved.

Installation

Ref ID

88953

Description

When running the Configure System utility to change the identity of ICONICS services from a
normal user to a Managed System Account (MSA) or vice versa, the ICONICS Hyper Historian
RawData Provider Host (HHRawDataProvider) service's user would not be correctly changed
and would remain running as the previous user. This has been resolved.
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Ref ID Description
The Hyper Alarm Server provider was missing in Workbench after installing 10.97 with a custom
88102 installation and only the "Client" modules selected. This has been resolved. The Hyper Alarm
Server should appear in Workbench as expected after applying this rollup.
The Configure System utility (which is utilized in the installation and can be launched
88906 standalone) would always fail when using a Managed System Account (MSA) account. This has
been resolved.

Language Aliasing

Language Aliasing Workbench Provider

Ref ID Description

After upgrading a language aliasing database from an older version, users may encounter an
88760 "Object reference not set to an instance of an object" error when attempting to edit language
aliases. This has been resolved.
The Language Aliasing provider now correctly alerts the user when invalid characters are used

86827 in alias names or if the name is longer than the allowed limit of 255 characters.

Licensing
Ref ID Description
For the purposes of licensing, point names with different capitalization were incorrectly counted
90940 as different points. This means the same physical tag could have been counted several times.
Now capitalization is correctly ignored for the purposes of counting licensing points.
When using the Reserved License feature, AlarmWorX64 Server and AlarmWorX64 Logger
87552 would not be able to use a reserved license when there was only one available reserved license
left. This has been resolved.

OPC UA

Ref ID Description
Added a new parameter to the OPC UA point manager called ConvertEUInformationToStruct.
This parameter defaults to false. When it is set to true, EngineeringUnits tags will be interpreted
as structures, allowing access to members (such as DisplayName, Description, or Unitld). When
it is left as false, EngineeringUnits is interpreted as a string and returns only the DisplayName
(which is consistent with the behavior from previous versions).

In order to set this parameter the first time, users will need to edit
FwxServer.PointManagers.config, find the FwxServerOuterUa section, then add this inside the
89541 <Params> section:

<Param>
<Name>ConvertEUInformationToStruct</Name>
<Value xsi:type="xsd:boolean">true</Value>
</Param>

Once the parameter has been added to the config file it can be changed in Platform Services
Configuration on the Point Managers tab.
Improved the speed of requesting OPC UA points. This is most noticeable for very large
numbers of points (in the thousands) all subscribed at once, such as upon startup.
In certain circumstances, OPC UA write requests could become stuck in a queue and never be
committed or would be committed much later than expected. This was more likely to happen
88286 when many writes were executed at the same time. This issue has been observed in
BridgeWorX64 when executing many OPC UA writes at once, but it could have occurred in
other OPC UA client applications performing writes.
Resolved an issue that could cause FrameWorX to slow or become unavailable for several
seconds when writing to OPC UA servers that may have a slow or limited connection.

88218

88710
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Project Reporting

Ref ID
88140

87260

87277

Description
The Runtime Use Report would generate with no data. This has been resolved.

If there were any fault models defined under AnalytiX > FDDWorX > Fault Diagnostic Models,
report generation involving Assets (such as the [Assets] All properties report) would fail during
the data collection phase with this error: "Cannot get the collection results for Assets - Error:
entity is not of expected type: EntityBase". This has been resolved.

Value and Status columns have been added to these Assets reports: Dynamic Tags, Expressions,
Polled Dynamic Tags, and Static Values.

Redundancy

Ref ID Description
Resolved an issue that could cause redundant servers to not appear or appear as offline in
88459 MonitorWorX's Redundancy tab even though they were functioning and actively providing
data. In some cases, the servers would appear once they were browsed in the Data Browser.
Security
Ref ID Description
The AddUser action of the Configure Security command did not function (the user was not
87977 . .
added to the given group). This has been resolved.
When using security in Azure Active Directory mode, user permissions were not being properly
87133 . .
applied from nested groups. This has been resolved.
Tools

Bulk Asset Configurator

Ref ID

88697

Description

If the Excel sheet used for the Bulk Asset Configurator input was configured to show the
phonetic field (an Excel feature), the characters from this field would be included in the assets
and objects created by the Bulk Asset Configurator. This has been resolved - the phonetic field
characters are no longer used if that field is visible.

Unified Data Manager

Ref ID

88783

Description

Resolved a crash in certain applications that could occur when the application read a data point
that did not start with the @ symbol and was of type TimeSpan. The crashing applications
included AlarmWorX64 Server, Unified Data Manager, DataSpy, and AlarmWorX64 Multimedia.
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AnalytiX

AnalytiX-Bl

Ref ID
88677

88941

89863

90564

90567
88541
89196
90128
90132
90133
90225
90361
90506
90551
90616

90866

87020

87570

87623

88468

88509

86621

86629

Description

Self-referencing views (such as a view named "View" with a query of "SELECT * FROM view") no
longer crash the AnalytiX-Bl server.

Collations in a query will no longer cause parse errors if the collation name contains upper-case
characters.

Resolved a memory leak that could happen when using the "Update and insert" trigger.

Queries that are upgraded from version 10.97 or and may produce different automatic column
names than they did in their original version. This has been resolved.

Example, this query, "SELECT ISNULL(Categories.CategoryID, 0)", in 10.97 would produce a
column named "CategoryID", however after upgrading to 10.97.1 it produced a column name
of "expr000".

Note that queries created new in 10.97.1 or later (not upgraded) will produce the new style
column names. The intent was that queries from previous versions should not have their
behavior changed when being upgraded, even if the same query created new might produce a
different result due to enhanced query logic in the new version.

Resolved a number of issues that could cause queries to fail or return incorrect results.

Resolved a rare crash in the Bl server that could occur when executing queries involving joins.

When security is enabled, the AnalytiX-BI server will not read or return any data. This has been
resolved.

Resolved a rare deadlock that could cause data flows and data models to suddenly start
showing bad quality after running for a period of time. When this issue occurred, the Bl Server
would be unresponsive and needed to be restarted. This issue would only happen on systems
where security was enabled and "Bl -> FWX" credentials were configured in Platform Services
Configuration on the Passwords tab.

Implicit joins involving a view would fail. Note that KPIWorX uses implicit joins, so this issue
could have resulted in KPIWorX returning no data for AnalytiX-BI queries involving at least one
view and another view or table.

Resolved an issue that could cause triggers to not fire during runtime. When this issue would
occur, an error along the lines of "Error while creating trigger..." will be posted to the
TraceWorX log. This issue could also have caused the AnalytiX-Bl service to raise an error and
crash while shutting down.

Previously, having a view with more than one column with the same name (such as a view with
this query: "SELECT CategorylD, CategorylD FROM Categories") would case the AnalytiX-BI
server to crash. Now, the AnalytiX-Bl point manager will disable views that return multiple
columns with the same name. A message will be posted to TraceWorX to explain why the view
was disabled.

Made an improvement in the performance of queries that use subqueries.

The COALESCE function may cause query errors when literal NULLs are used as parameters, and
one or more other parameters are one of these types: bool, string, byte, sbyte, Int16 or UInt16.
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Ref ID
86656

87091

87263

87268

87357

87458

87467

Description

The totimezonetime() function would cause an "unsupported data type" error when used as
part of a query. This has been resolved.

View parameters of type Native are not supported by AnalytiX-Bl; however, Workbench allows
them to be created. Previously, views created with Native parameters would appear to have
been created properly but would not be visible when browsing. This has been resolved by
treating parameters of type Native as if they were type String. Future versions may remove the
option to create Native parameters from Workbench and convert any existing Native
parameters to String.

Improved grouping performance, especially when grouping by a string column.

The .@@Count point applied to a dynamic query (example: bi:Models:Northwind(SELECT *
FROM Employees).@@Count) was no longer working in 10.97.1. This has been resolved.
Resolved an error that could prevent data from being loaded into a data model table from a
dataflow when both the table and the dataflow contained a hierarchical column (such as an
asset path).

Queries including both the JOIN and GROUP BY clauses would fail to execute, citing the GROUP
BY column did not exist. This has been resolved.

On localized systems, the Runtime Status points (Status, Last Updated and Row Count) shown
in the Data Table configuration form in Workbench would report a bad quality value. This has
been resolved.

AnalytiX-Bl Workbench Provider

Ref ID

89199

Description

In previous versions, when testing a query with parameters, Workbench would substitute the
parameter value as a string, even if the parameter was a different type. Now, Workbench
explicitly casts the parameter's test value to the appropriate type, which creates a more
accurate test query.

This issue may have caused errors when testing in certain circumstances, such as if the query
contained both non-string parameters and a UNION.

BridgeWorX64 & Workflow

BridgeWorX64 Server

Ref ID

89230

88286

86890

Description

Resolved an issue causing BridgeWorX64 to consume one extra transaction license. This issue
could have caused a transaction to not execute due to insufficient licensing if the system was
configured to use the maximum number of transactions allowed by their license.

In certain circumstances, OPC UA write requests could become stuck in a queue and never be
committed or would be committed much later than expected. This was more likely to happen
when many writes were executed at the same time. This issue has been observed in
BridgeWorX64 when executing many OPC UA writes at once, but it could have occurred in
other OPC UA client applications performing writes.

Resolved a rare crash (NullReferenceException) in the BridgeWorX64 or CFSWorX engine. The
crash involved using a Bulk Tag Writer or Bulk Tag Reader activity with a tag list that came from
a database query, and the result of that database query contained null or empty tag names.

BridgeWorX64 Workbench Provider

Ref ID

86697

Description

In BridgeWorX64, CFSWorX, and Workflow diagrams that were upgraded from a previous
version, any parameters for Start Time and End Time in Historical Alarm or Historical DA
activities were unable to be changed in version 10.97.1. This issue has been resolved. (This was
documented as a known issue in 10.97.1.)
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Workflows Workbench Provider

Ref ID

86697

Description

In BridgeWorX64, CFSWorX, and Workflow diagrams that were upgraded from a previous
version, any parameters for Start Time and End Time in Historical Alarm or Historical DA
activities were unable to be changed in version 10.97.1. This issue has been resolved. (This was
documented as a known issue in 10.97.1.)

CFSWorX

General

Ref ID

88647

88790

89113

89878

89919

90781

87947

88308

88707

86890

87047

87064

Description

Connected Field Service Workflows were not being triggered on systems upgraded from 10.97
or earlier when the CFSWorX Workflows Point Manager was configured to run in-process. This
has been resolved.

When a worker lookup was configured with "Send to all Workers at same time", the activity that
consumed the worker list (such as Twilio Message) may have sent the message to the "To
address" configured in the activity for all messages, rather than the contact info of each worker.
This has been resolved.

If a worker's "Enable on Tag" field was configured to be an AssetWorX property, the worker
would always be disabled when the CFSWorX engine started, even if the AssetWorX tag had a
value of true. CFSWorX would have to be running while the tag transitioned from false to true
in order to properly enable the worker. This has been resolved.

Note, while this issue was most commonly seen with AssetWorX tags, it could have happened
with other tags as well under specific circumstances.

If a worker's Alarms tab contained an alarm string that included a remote node (such as
"@\\Server\ICONICS.AlarmSvr.1\Plant Area B"), that worker would not be notified. This has
been resolved.

Resolved an issue causing the Repeat Contact List activity to sometimes return an empty worker
list. This issue would have been more likely to happen if the Worker Lookup activity that
preceded the Repeated Contact List activity had the "Send to all Workers at Same Time" option
enabled.

Resolved an issue preventing CFSWorX workflow configurations from subscribing to GenEvent.
Attempting to subscribe to GenEvent in the past would result in this message in TraceWorX:
"Cannot retrieve the source value. There isn't any field with the event type name and the field
name specified".

When using the SendGrid Email or Sendinblue Email notification blocks, if more than 255
characters were entered into the To, Cc, or Bcc address fields (such as when entering multiple
email addresses), the email would be sent normally but would not be logged. For SendGrid, this
failure to log the outgoing message would have prevented acknowledging the triggering alarm,
as the system could not find the original message in its log and did not know what should be
acknowledged. (Note that Sendinblue does not support acknowledgement, so this issue was
less apparent with Sendinblue.) This has been resolved.

Resolved a rare crash of the ICONICS Connected Field Worker Workflow Scheduling Service
(IcoCFSWFScheduling.exe).

Resolved a rare crash of the ICONICS Connected Field Worker Workflow Point Manager
(FwxCFSWFService.exe).

Resolved a rare crash (NullReferenceException) in the BridgeWorX64 or CFSWorX engine. The
crash involved using a Bulk Tag Writer or Bulk Tag Reader activity with a tag list that came from
a database query, and the result of that database query contained null or empty tag names.
SendGrid Email activities that were upgraded from a previous version to 10.97.1 would fail.
SendGrid Email activities that were newly created in 10.97.1 would work fine. This has been
resolved.

The syntax for alarm fields in Alarm Filter expression on Field Workflows changed slightly
between 10.97 and 10.97.1. Version 10.97 required the full field name, such as
{{BaseConditionType.OriginalSource}}, where version 10.97.1 would only accept the short field
name, such as {{OriginalSource}}. Now, the full field name is converted on the fly to the short
field name, so filters that were originally configured in earlier versions will continue to work.
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CFSWorX Workbench Provider

Ref ID

86697

Description

In BridgeWorX64, CFSWorX, and Workflow diagrams that were upgraded from a previous
version, any parameters for Start Time and End Time in Historical Alarm or Historical DA
activities were unable to be changed in version 10.97.1. This issue has been resolved. (This was
documented as a known issue in 10.97.1.)

Energy AnalytiX

Ref ID
87740

87816

87870

87008

Description

Delta counter meters with rollover will now ignore abnormally high meter values (20% above
the meter-configured rollover value).

Added protection to meter counters so they ignore negative consumption values coming from
the meter.

Improved the behavior of normalized energy consumption when historical data (especially
imported historical data) is sparse or there are long periods between updates. Previously, the
calculation may have treated these sparsely updated values as zero when there was no sample
in range for the calculation. Now, the calculation is better able to find the last logged value
even when it falls outside the calculation range. Users may want to ensure their data is
recalculated for these sparse periods after applying this update in order to fully benefit from
this enhancement.

The sample Energy AnalytiX data model has been improved to take advantage of the
parameterized views feature of AnalytiX-Bl that was new in version 10.97.1. These new
parameterized views were added to all data models and make it easier to get information on
energy data in clients like the GridWorX Viewer. The new views start with the name "SP_" and
contain descriptions and comments that should help users understand their use.

These new parameterized views are included in the new
EnergyDashboard_Pack_10.97.10.CFR1.pkgx file which should be installed by the rollup. For
preexisting Energy AnalytiX projects, before unpacking this file, delete all energy dataflows and
data models from AnalytiX-BI, delete all energy analysis triggers from Actions, and rename or
delete existing energy KPIWorX-BI dashboard files. The pack file is located by default in
Program Files > ICONICS > GENESIS64 > AnalytiX Dashboards.

Facility AnalytiX & FDDWorX

Ref ID

89308

90377

90668

Description

Previously, when a fault rule expression produced a null or empty value, it would be evaluated
as false. This could lead to faults being cleared and re-triggered if there was a network
interruption or other brief situation that caused bad quality. Now, null or empty values are not
converted to either true or false, causing the fault to remain with its previous state.

Users are recommended to use the IFQ expression instead of IF in their fault rule expressions
and enabled expressions.

Example: x= IFQ (_condition_) THEN 1 ELSE O

Resolved an issue that would cause the SourceFaultDeactiveTime of a fault instance to show
null if changes were made to the fault while the FDDWorX service was stopped. (The
FaultDeactiveTime would change as expected.)

Note that deleting a fault while the service was stopped may still result in a null
SourceFaultDeactiveTime.

The FaultincidentsAdvancedRecovery INI entry (used to continue faults using "trueforduration”
after a server restart) did not function as of version 10.97.1. This has been resolved.
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Fault Viewer

Ref ID

89517

88523

86615

Description

Displays created in 10.97.0 or earlier would lose the automatic width setting of columns in the
Table Control or Fault Viewer after the viewer was edited and saved in the new version. This has
been resolved, but only for displays that are newly upgraded. Displays that were already saved
in a version that had this issue will have permanently lost their automatic width configuration
and will need to be reconfigured.

When in a grouped view, such as "Fault Statistics", the timeline grouping was incorrectly
stacking up between rows, leading to lower rows showing an incorrect amount of active time.
Rows far enough down could show completely full (active all the time). This has been resolved.
The Table control and Fault Viewer would stop displaying timeline, microchart, or other array
data when the grouping was changed. This has been resolved.

ReportWorX64 & ReportWorX64 Express

Common

Ref ID

90842

87662

87861

88079

88152

87413

Description

The number of columns allowed in a single data source has been increased. It should now be
possible to create data sources with the maximum number of columns supported by Excel in a
single worksheet.

If ReportWorX64 Server generated a report that contained data sources that returned no data,
then the user tried to open that Excel sheet on a system with the ReportWorX64 Excel Add-in
enabled, errors would appear such as: "The template is in data mode, but the data source
cannot be loaded properly because it is missing the coordinates of its data area.”

This has been resolved.

When ReportWorX64 Server generated a report, only the formulas defined in custom columns
were calculated when the report was saved. Formulas elsewhere in the workbook would not be
calculated. This was not generally noticeable when opening an XLSX report in Excel, as Excel
would recalculate the values automatically when the file opened, but XLSX reports opened in
"preview mode" or reports in other formats such as HTML or CSV would not show the correctly
calculated values. This has been resolved.

If a dataset included columns with names that included a colon, those columns would not be
populated with data in the final report. Most notably, this issue affected additional fields that
could be added to a Hyper Alarm Logger subscription. This has been resolved.

When parameters were used in ICONICS expressions (such as when used in another parameter),
the parameter was not always evaluated correctly, causing the expression to return an incorrect
result. This has been resolved. The specific cases that were addressed involved using a datetime
parameter in an expression and referencing string parameters via two or more layers (for
instance, <<param0>> was used in the expression for <<param1>> which was in turn used in
the expression for <<param2>>, and all three were string parameters).

"Automatically evaluate a date and time" parameters would incorrectly use the time that the
report was run, not the configured time. The date would correctly be set as configured. This has
been resolved - now both the date and time are as configured in the parameter.

ReportWorX64 Express & Excel Add-In

Ref ID
89118

90172

87736

Description

If an HDA data source was configured using a tag containing a wildcard (*), no data would be
retrieved. This has been resolved.

On systems where the culture used by Excel and the culture used by the operating system had
different date formats, datetime fields in data sources and parameters may interpret the date
incorrectly or use default values. This has been resolved.

Addressed two errors that could cause this error message to appear when editing a previously
saved template: "An error occured during the execution of the operation, the error was caused
by an internal error of Excel; you should be still able to edit your template, in case of error try to
open again the template."
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Ref ID

87883

88000

88185

88191

88409

87032

87034

87036

87167

87193

87471

Description
The first resolved error would occur if the worksheet name contained special characters or
spaces.

The second resolved error involved a parameter cell mapping that was defined internally in an
unexpected way. We are not clear what caused this oddity in the definition, but ReportWorX64
now accepts it without errors.

Charts created by ReportWorX64 (Edit > Chart Settings) would sometimes place all samples for
the same day on the same X position. For example, when reporting on hourly historical data, all
the hourly samples for one day would be plotted over the same label for that day. This has
been resolved.

When configuring a parameter's default value, the form would not allow the user to apply the
changes if the value was an expression including a tag. This has been resolved.

If the ReportWorX64 Excel add-on was enabled, opening certain templates would cause Excel
to become unresponsive. This has been resolved. Templates that previously caused this issue
will now perform as expected with no freezing.

Editing any data source to reduce the number of headers (such as changing the tag to one with
fewer columns or changing a Hyper Historian data source from Advanced to Simple column
style) then saving and reopening the file would result in a Microsoft Excel message appearing
that said, "We found a problem with some content in '<file name>". Do you want us to try to
recover as much as we can? If you trust the source of this workbook, click Yes." This issue has
been resolved. (Note, selecting "Yes" to the message would have successfully recovered the
template with no data loss.)

When downloading data in the Excel add-in, formulas in the anchor row were not correctly
updated if the formula used a range of cells (example: "=SUM(A4:B4)") where the range did not
match the range of the data source column above it. This has been resolved.

In the ReportWorX64 ribbon, the "Hide header" checkbox was erroneously labeled "Open
lateral data browser". This has been resolved.

If a new column was added to a data source using the "Add Column" function, then the column
was configured as a custom column, the column would not download any data. This has been
resolved.

Tags that had multiple types (such as DA and HDA) could not be added as a data source in the
ReportWorX64 Excel add-in. This error would appear: "The selected data source is not
supported by ReportWorX64 add-in and cannot be created." Most notably, this prevented
Hyper Historian tags from being added as they were both DA and HDA. This has been resolved.
Sort settings (configured in Edit Data Source > Sort Header) were not being properly applied to
HDA data sources when the data was downloaded. This has been resolved.

If a user added a chart (Edit > Chart Settings) to a template but did not fully configure the
chart, then saved the template, the template would not be able to load properly when it was
opened again.

Resolved an issue preventing parameters from being added to templates on systems using
Russian localization. The parameters form appeared empty and grayed out.

ReportWorX64 Server

Ref ID
88538

87936

88146

87247
87246

Description

Data sources configured without headers could miscalculate formulas in the anchor row. This
has been resolved.

Formulas in anchor rows of data sources without headers were not properly expanded when
the data source was populated. The formulas would be properly updated when downloading
the data directly in Excel, but not when executing the report from ReportWorX64 Server. This
has been resolved.

Reports executed through the ReportWorX64 Service would not respect the "Date Time
Format" or "Double Format" properties configured in the data source. This has been resolved.

Resolved an issue that would prevent Send Email redirector commands from sending.
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Data Connectivity

BACnet Connector

BACnet Classic

Ref ID

89843

88202

Description

The BACnet EDE Generator (IcoBACnetEdeGenerator.exe) would display this error when using a
BACnet Classic configuration: "lcoBACnetEdeGenerator Error: BACnet Channel information is
not available. Check configuration database.” This has been resolved.

Note that the BACnet EDE Generator now only works with BACnet Classic configurations, not
with the BACnet with SC technical preview configuration.

Resolved an issue that could prevent the BACnet point manager from resubscribing to tags at
the configured re-subscribe COV period. This issue would occur after the device had gone
offline and then back online again.

GridWorX (Databases)

GridWorX Server

Ref ID

89937

Description

When inserting rows into a GridWorX Server data source (most often done with a GridWorX
Viewer), if the data was being inserted into a table with a primary key that was set to auto-
increment, the data would be correctly inserted into the database, but the primary key value
could be erroneously shown on the client as a very large number. This has been resolved.

GridWorX Viewer

Ref ID

88929

87695

86696
86701

87071

Description
The data in GridWorX data sources was not updatable in the Data Explorer. This has been
resolved.

This issue may have also occurred in a GridWorX Viewer if the viewer's subscription was
changed in runtime mode. It was also resolved in this case.

Users were unable to edit the command configured for a virtual field. When attempting to edit
the command, it would look as if the user were adding a brand-new command. This issue
affected both the AlarmWorX64 Viewer and GridWorX Viewer and has been resolved for both
controls.

GridWorX Viewer charts wouldn't render in runtime or would crash if VerticalLabelOffset,
VerticalAxisStep, or HorizontalAxisStep were set to a negative value. This has been resolved.
Improved the performance when loading displays with multiple GridWorX Viewer controls
containing charts. Certain displays had their load times reduced from 30 seconds to 5 seconds.
(Actual loading times may vary depending on the system specifications and the number of
charts.)
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Mitsubishi Electric Factory Automation (FA) Connector

Ref ID
89416

90041

87656

87970

Description
Resolved an issue causing the Mitsubishi Electric FA Connector to write unexpected values for
continuous registers.

Resolved a crash (System.lO.FileLoadException) in the Mitsubishi Electric FA Connector.

Resolved an error that would occur when connecting to a Q02U device.

When multiple bit registers are set as tags, only one tag would be updated in clients. This has
been resolved.
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Modbus Connector

Ref ID Description
Enhanced the performance of the Modbus point manager. This performance enhancement will
88211 be most noticeable with configurations of 1,000 or more points and those with multiple clients
connected.
88660 Resolved a crash of the Modbus Point Manager. The crash exception was: "FileLoadException :

Could not load file or assembly 'System.|O.Ports".

SNMP Connector

Ref ID Description
Resolved an issue causing connections (publisher and subscriber) to MQTT Sparkplug brokers

88186 to fail when configured to use the Web Sockets protocol.

Web Services Connector

Ref ID Description
Resolved an issue preventing children of a web manipulator's @ @Data tag from getting data.
90325 The @@Data tag itself would work, but it was impossible to drill down to individual properties

of the result.
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GENESIS64

Alarms and Notifications

AlarmWorX64 Multimedia

Ref ID
90575

90890

88783

Description
Added support for OAuth 2.0 when connecting to email servers over SMTP.

Resolved an issue that could occur when using multiple email agents for more than one SMTP
service. AlarmWorX64 Multimedia's agent may have chosen the wrong TLS level to establish a
connection to the SMTP server, causing a connection failure due to a mismatch of this security
protocol.

Resolved a crash in certain applications that could occur when the application read a data point
that did not start with the @ symbol and was of type TimeSpan. The crashing applications
included AlarmWorX64 Server, Unified Data Manager, DataSpy, and AlarmWorX64 Multimedia.

AlarmWorX64 Server

Ref ID

88031

88783

86900

87117

Description

Configuration changes that disable alarms often cause a notification update. When this update
occurs the default subcondition, Rate of Change, was used. Now, instead of Rate of Change, a
subcondition associated with the alarm type is used instead. (For example, limit alarms will use
"lolo".)

Resolved a crash in certain applications that could occur when the application read a data point
that did not start with the @ symbol and was of type TimeSpan. The crashing applications
included AlarmWorX64 Server, Unified Data Manager, DataSpy, and AlarmWorX64 Multimedia.
When a redundant alarm server switches from active to standby, the alarm server now clears all
of its cached alarms. This clear does not affect what a client sees. Clearing the cache in this way
helps the alarm servers stay in sync. This way, the alarm server that is now standby will not be
working with a set of data that may have become inconsistent with the now-active alarm server.
This change should help prevent situations where alarms are lost or duplicated after an incident
where both alarm servers had become active (which could occur if the network connection
between them was offline) but were getting live data that may not have been consistent
between the two servers, causing them to become out of sync.

When the IgnoreQualityChange INI entry was set to 1, updates with some uncertain quality
states were not properly ignored. This has been resolved.

AlarmWorX64 Viewer

Ref ID

89419

90624

90755

Description

Having a significantly long expression could make the Configure Alarm Filter dialog taller than
the available screen space, making it impossible to access parts of the form, including the OK
and Cancel buttons. This has been resolved.

When making changes to an alarm viewer's subscription (such as when changing a global alias
used in the subscription or configuration file), sometimes individual alarms would fail to be
displayed due to a timing issue. This has been resolved.

Added a new property, EnableBeepCompatibility, to the Advanced tab of the AlarmWorX64
Viewer (at the viewer level). This property defaults to false, which is consistent with the behavior
in previous versions.

When EnableBeepCompeatibility is set to true, the viewer will be unable to use custom sounds
for individual conditions. Only one custom sound can be used, the sound specified in the
CustomBeepFileLocation property of the control (at the the viewer level). (When
EnableBeepCompatibility is set to false, CustomBeepFileLocation is ignored.)
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Ref ID

90762

87695

87766

87097

Description

User may want to set EnableBeepCompatibility to true if their AlarmWorX64 Viewer tends to be
left open for long periods of time while playing sounds, as this situation may cause a small
memory leak. The memory leak is small enough that it will not have any noticeable effect on
most systems. ICONICS is investigating a resolution of this leak that will allow multiple custom
sounds, but in the meantime this property can be used to mitigate the leak on systems that
may be affected by it.

Resolved an issue that could cause a freeze or hang of the display when downloading many
historical alarms.

Users were unable to edit the command configured for a virtual field. When attempting to edit
the command, it would look as if the user were adding a brand-new command. This issue
affected both the AlarmWorX64 Viewer and GridWorX Viewer and has been resolved for both
controls.

Null values in virtual DateTime fields were being rendered as 0001-01-01 0:00 instead of a
blank value. This has been resolved.

The AlarmWorX64 Viewer was confusing the contents of the BaseEventType.Time field with
other fields that started with the same string, such as BaseEventType.TimeZone. The most
obvious result of this issue was that when the AlignTimeZone feature (on the Advanced tab)
was enabled for a historical alarm grid, the TimeZone column would show the value of the Time
column instead of the proper time zone indicator, however other BaseEventType field names
that started with "Time" could have been similarly affected. This has been resolved.

Also, only the ActiveTime and Time fields were being converted into the proper time zone. This
was resolved as well.

AlertWorX

Ref ID
88813

89547

90520

87772

87959

88432

86398

Description
Resolved an issue that would prevent the alert archiving from running.

Systems upgraded from an earlier version may fail to log SMS, Voice, or WhatsApp messages.
These logs are used for alarm acknowledgement, so users would be unable to acknowledge
alarms via these methods. This has been resolved.

When the issue occurred, this message would appear in TraceWorX whenever the system
attempted to log one of these messages:

Cannot log the message details Following exception occured: Invalid column name
'‘BaseEventTypeSourceName'.
Invalid column name 'BaseConditionTypeConditionName'.

Added support for OAuth 2.0 when connecting to email servers over SMTP.

Resolved an issue in AlertWorX email or SMS/text alarm subscription alerts where alarm fields
were not resolved if there were two or more attributes in the same field.

The Subject and Message fields of AlertWorX Message Templates allowed for browsing an
alarm field and inserting a tag, but neither of these options created a usable expression for
these fields. This has been resolved - the "Browse tags" and "Add alarm field" links were
replaced by an "Expression editor" link that helps the user properly create an expression usable
in Message Templates.

AlertWorX email nodes would still send messages from the attached alarm subscriptions even
when the "Enable the email node" box was unchecked. This has been resolved.

Twilio would ignore configured language settings unless the language in question was specified
for the DefaultCulture and DefaultUICulture settings in the appsettings.json file. This has been
resolved. Now the desired language only needs to be added to the SupportedCultures array.
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Hyper Alarm Logger

Ref ID

88486

86970

87198

Description

Resolved a rare exception that could cause the Hyper Alarm Logger to crash immediately after
being started some of the time. This exception would appear in TraceWorX as this severe error:
"NullReferenceException : Object reference not set to an instance of an object."

In a redundant scenario, if both servers were taken offline and only the secondary Hyper Alarm
Logger was started, it would not become active. It would only become active if it had already
established connection to the primary Hyper Alarm Logger and that connection was lost. This
has been resolved.

A Hyper Alarm Logger configuration that was disabled could not become enabled again until
the Hyper Alarm Logger service was restarted. This has been resolved.

AssetWorX

Ref ID

87729

87974

Description

When using AssetWorX Tag Counting mode (used with GENESIS64 Basic SCADA), alarms
created directly on AssetWorX properties using the Alarm tab would not function. These alarms
worked fine when using Advanced Tag Counting mode. This has been resolved.

Writing a value into an AssetWorX equipment property tag whose Real-Time Data tag was
configured with "None" as the Source Type would cause a crash in AssetWorX. This has been
resolved.

Asset Navigator

Ref ID

88889

Description

In situations where there were native features of the Asset Navigator that took action on the
same trigger as a command (for example, the "Path Storage" native feature stores the selected
asset to a global alias when the path changes, and there may also have been commands
configured to execute when the path changes), the command would be triggered first, followed
by the native feature of the navigator. This was inconsistent with the desktop (WPF)
implementation, which triggered the native features first, followed by any commands. The
HTMLS implementation has been changed to be consistent with the desktop (WPF)
implementation, so the native features are now triggered first.

However, note that due to the asynchronous nature of some of these actions, there is still no
guarantee that one action will finish before the next action is executed. (So, in the example
above, the navigator will instruct global aliases to update its value before executing the
configured command, but in some cases the global alias may still not have the updated value
before the command is executed.) If users are in a situation where one action must complete
before another should execute, they are encouraged to use batch commands to perform both
actions instead of using native navigator functionality. Batch commands can be configured to
wait for one command to complete before proceeding to the second. This recommendation
applies to both WPF and HTMLS5 platforms.

AssetWorX Workbench Provider

Ref ID

88688

Description

Resolved an issue that would prevent an AssetWorX configuration export from being imported
into another configuration if the export contained asset properties whose Historical Data tab
was configured with one of the Hyper Historian source types.
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Controls

Camera Control

Ref ID

88778

Description

Resolved an issue that could cause the camera control to ignore parameters specified in the
video URL. This would most often affect parameters after the first. For example, if the video URL
was http://<ip>/mjpg/video.mjpg?camera=18&resolution=320x240, the Resolution parameter
may have been ignored. This issue affected both desktop (WPF) and HTML5 camera controls
and has been resolved for both platforms.

EarthWorX Viewer

Ref ID
89273

90264

Description

Resolved a crash that could occur on Chinese systems with the language pack installed. The
crash would happen when adding an EarthWorX Viewer to a GraphWorX64 display.

Resolved an issue with the EarthWorX Viewer for WPF WebHMI (which requires Internet
Explorer or Edge using IE Compatibility mode) that would cause the map to display incorrectly.

Table Control

Ref ID

89517

87935

86615

86919

87409

Description

Displays created in 10.97.0 or earlier would lose the automatic width setting of columns in the
Table Control or Fault Viewer after the viewer was edited and saved in the new version. This has
been resolved, but only for displays that are newly upgraded. Displays that were already saved
in a version that had this issue will have permanently lost their automatic width configuration
and will need to be reconfigured.

The table control's auto-refresh would not function after the data source was changed in
runtime, such as if the data source was a global alias and the alias value was updated. This has
been resolved.

The Table control and Fault Viewer would stop displaying timeline, microchart, or other array
data when the grouping was changed. This has been resolved.

Automatic refresh of the data could not be configured. The Refresh Rate checkbox (on the
General page in the Data section) would not stay selected. Selecting it, selecting OK, then
returning to the configuration would reveal that the box was no longer selected. This has been
resolved.

When using the Time Shift setting for a pen, samples might not be displayed. The further into
the past the pen was shifted, the more samples would be missing. This has been resolved.

TrendWorX64 Viewer

Ref ID
88666

88735

89806
90410

89807

Description

The FitMarginLabels advanced property wasn't respected after the display was saved and
reloaded. This has been resolved.

In the TrendWorX64 Viewer configuration dialog on the X Axis tab of the chart object, the Date
and Time Format dropdown menus did not scale properly on systems where the Windows
display scaling was set to something other than 100%. This has been resolved.

Added a new property to the Advanced tab of the chart, ReadTimeRangeWhenZoomed. When
set to true, updates to the time range data source (configured on the chart’s Range tab) will be
applied even when the viewer is zoomed in. When set to false, updates to the time range data
source will be paused while zoomed. The viewer will remember the last update from the time
range data source and apply it when the viewer's zoom level is reset to the default. This
property defaults to true, which is consistent with the behavior in earlier versions.

Resolved a rare crash that could occur when the TrendWorX64 Viewer plots a dataset.
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Ref ID

90479
90480

90818
90817

87044
87185
87187
87326
87382
35362

87383
87384

87447
87448

Description

Added a new option for displaying cursor value. On the chart object's Cursors tab under
"Sample Selection" there is a new option named "Interpolate”. When Interpolate is selected, the
cursor tooltip will display a value interpolated from the previous and next sample. (This option
is unrelated to the interpolative aggregate and can be used regardless of the pen aggregate.)
The "interpolate" sample selection option only works for area or line plots.

Note that this option will not be localized. It will appear in English, regardless of the system
language. Future versions will be properly localized.

Added a new advanced property to the chart object called AlternativeRangeAxisAreaSize. This
property acts like RangeAxisAreaSize (which sets the area available for the range axis
information to be drawn) except it applies to the side of the viewer where ranges configured
with "alternative placement" are located (usually the right side).

Historical data exposed through GridWorX Server (db: tag) would fail to read the sample
quality. This has been resolved.

The autoscale feature would not pick proper min or max values for a static data source. This has
been resolved.

Other than the default shared axis, a shared axis configured with auto scaling would ignore the
Auto Scale Margin value. This has been resolved.

Added these new possible actions that can be configured in the context menu: "Show Legend",
"Show Cursors", and "Export Data".

Added two new properties to pens that can be set on the Advanced tab of a pen. These
properties are "ShowInCursors" and "ShowlnLegend". They are true by default. When set to
false, this pen will not be shown in the cursor tooltip or legend, respectively. These properties
are respected by both the desktop (WPF) and HTML5 TrendWorX64 Viewers. They can also be
set in Create Pen and Edit Pen commands.

Added a new property, "FitMarginLabels", to the chart object. It can be edited on the Advanced
tab when the chart is selected. When set to true, the labels at the very beginning and end of the
X axis will be adjusted to fit within the margins. When set to false (which is the default value
and consistent with previous versions), these labels might be cut off by the viewer. This
property is respected by both the desktop (WPF) and HTML5 TrendWorX6é4 Viewers.

Data Explorer

Ref ID

88929

87743
87744

84452

Description
The data in GridWorX data sources was not updatable in the Data Explorer. This has been
resolved.

This issue may have also occurred in a GridWorX Viewer if the viewer's subscription was
changed in runtime mode. It was also resolved in this case.

Resolved an issue preventing the Data Explorer from displaying data when a Hyper Historian
folder was selected. This has been resolved for both desktop (WPF) and HTML5 Data Explorers.
Resolved a crash of the data explorer that could occur when selecting a device that contained a
proprietary BACnet object.

GENESIS64 Basic SCADA

Ref ID
89665

90490

Description

It is now possible to view Hyper Alarm Logger logged data when using AssetWorX Tag
Counting mode (used for GENESIS64 Basic SCADA).

Systems running using AssetWorX Tag Counting mode (used by GENESIS64 Basic SCADA)
would not allow browsing for third-party AE servers. This has been resolved.

Note that when using AssetWorX Tag Counting mode users are expected to add third-party AE
servers to AssetWorX (Assets > Product Configuration > Alarms & Events settings > General
settings and Alarm & Events sources).
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GraphWorX64

Ref ID

89374

89604

90093

90664

90682

87646

88278

88411

86307

86395

Description

Triggering a display to load via the global Load Graphics Display command when another
display has not yet finished loading could rarely cause an exception and crash GraphWorX64.
When this situation occurred this error message would be displayed: "An attempt was made to
transition a task to a final state when it had already completed". This rare issue has been
resolved.

Resolved an issue where the data layer for executing commands would use a different scan rate
than the overall display. This could have resulting in unexpected behavior from local variables
when using commands, because the commands would be interacting with a different instance
of the variable than the one used by the rest of the display.

Users can now disable scripting in their GraphWorX64 installations by making a change to a
configuration file. Disabling scripting will help you secure the automation system or developer
station as a whole. ICONICS encourages integrators to use a holistic approach

to security by looking at all elements of your architecture.

Scripting is enabled by default. To disable scripting, edit the Gwx.config.xml file (located by
default in C:\Program Files\ICONICS\GENESIS64\Components), search for "ScriptingEnabled",
and set the value to false.

Resolved a slow memory leak in GraphWorX64 and Workbench.

Previously, layers nested in any other layer disabled the NoZoom, NoPan and NoScrolling
properties. Now these properties are disabled only if there is an ancestor layer that has
NoZoom, NoPan or NoScrolling configured.

When connecting a Remote Desktop to a session that already has GraphWorX64 running, the
user could experience issues with global aliasing and embedded viewers. Specifically, global
aliases inside an embedded viewer that were already set would revert to their default values,
and further Set Global Aliases commands would be ignored. These issues have been resolved.
Resolved an issue in the Data Browser that appeared in 10.97.1 Critical Fixes Rollup 1 which
would cause applications such as GraphWorX64 or Workbench to hang in task manager after
they were closed if the pop-up Data Browser had been used.

Resolved a crash in GraphWorX64 that could occur when editing the text of labels that used a
gradient as the foreground color. This crash was observed on systems configured with Japanese
input mode; however, it could occur with other languages or system configurations.

Resolved an issue causing some tooltips in the Smart Tile configuration to not be properly
localized.

Dragging points from the Assets or Hyper Historian branches of the data browser into
GraphWorX64 caused this error: "There is no compatible data to paste.” This has been resolved.

Web Publishing Wizard

Ref ID

89847

Description

Resolved an issue causing the Web Publishing Wizard to incorrectly swap the file names of
viewer configuration files when there was more than one of that kind of viewer in the published
display. The viewers that could have triggered this issue were AlarmWorX64 Viewer, GridWorX
Viewer, or TrendWorX64 Viewer.

RecipeWorX

Ref ID

90686

Description

Deleting recipe items could cause unintended behavior with recipe management tags that
specified the index number, such as rcpm:RecipeData.Value(*MyRecipe",5). Some indexes would
show as blank. This has been resolved.
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ScheduleWorX64

Ref ID Description
Resolved an issue in the ScheduleWorX Point Manager that could have caused the schedules to
86746 fail to load in the Schedule Control in certain cases. This issue was more likely to occur when
multiple clients or multiple schedule controls were being used simultaneously.

Schedule Control

Ref ID Description
When using the "Override BACnet Enum Values" functionality of the BACnet Schedule Viewer,

87781 the background color was not applied with floating point values.
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Hyper Historian

Collector

Ref ID

86749

Description

Resolved a crash in the Hyper Historian Collector service (when running the standalone
collector) or the Hyper Historian Logger service (when running the in-process collector). This
crash would only occur when a Hyper Historian tag's data type was configured as "UInt8 (8 bit
unsigned integer)" with the "Is Array" option enabled.

Hyper Historian Express

Ref ID
88391

Description

Hyper Historian Express now allows the use of up to six loggers.

Hyper Historian Workbench Provider

Ref ID

89272

88761

88762

Description

In the unusual case that users made a certain manual update to version 10.95.5 Hyper Historian
configuration database at the recommendation of technical support, this database would fail
the upgrade process. The specific update was to add a
"CacheConfiguration_DatablocksLimiterTreshold" row to the "HH_MasterConfiguration" table.

This issue has been resolved. Version 10.95.5 databases that include this row should now
upgrade appropriately.

When using the "Merge Another Historian" feature of Hyper Historian to receive data from a
specific device of an loT Subscriber, data from all devices would be merged, not just the
selected device. This has been resolved.

When using the "Merge Another Historian" feature of Hyper Historian to receive data from an
loT Subscriber, ":rawMessages" tags were erroneously being added to the configuration. This
has been resolved.

Logger

Ref ID

87710

87727

87752

87854

87234

87236

Description

Resolved a crash of the Hyper Historian Logger engine that could occur on systems that had
one or more calculated tags that referenced a function that referenced another nested function
and used at least one parameter as a data point. The crash would occur when the problem
calculation was processed (either during normal operation or during a recalculation task).

The HistoryEraser.exe tool can now take a file name as a parameter. This file should be a text
file with the names of historian points, one point per line. When this parameter is used,
Historian Eraser will load with this list of tags pre-filled, providing an easier way to erase large
numbers of tags at once.

In very rare cases, an unfinished transaction can be stored into the Hyper Historian log files, and
when one of these unfinished transactions is present, Hyper Historian would not start. In this
situation, TraceWorX will log the error, "Exception in single thread processing". Hyper Historian
will now complete these types of unfinished transactions when it sees them, and the engine will
start properly.

Setting the Master Logger Directory and Product Directory to locations on different drives (such
as one was on the C drive and the other was the D drive) would result in data not being logged.
(These are configured under System Administration > System Settings. Master Logger Directory
is on the File Logger tab and Product Directory is on the Options tab.) This has been resolved.
Re-calculation tasks in the Aggregate Task Manager would not recalculate if the task was
configured with a tag filter and used an aggr: tag. This has been resolved but note that all
aggregates for the chosen tag will be recalculated, not just the aggregate chosen in the filter.
The "Starting at" time for a logger would always use UTC time, even if configured to use local
server time.
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SQL Query Engine
Ref ID Description First Available In
New for Critical

88979 Resolved a memory leak in the Hyper Historian SQL Query Engine. s w3



loTWorX & Internet of Things

Ref ID

89369

89581

87620

86638

87039

87424

Description

For systems with TLS configured on an MQTT Broker that require a client certificate,
connections to MQTT brokers may have failed because the client certificate was not being
copied to the correct location. This has been resolved.

Resolved a memory leak in the ICONICS Internet of Things Subscriber Service
(FwxlotSubscriberService) that would occur when subscribing to buffered data.

Updated the version of Node.js and Node modules in the loTWorX container.

Updated the base loTWorX container image with ASP.NET Core 3.1.19.

It was not possible to browse the loT alarm types in the loT Subscriber when creating an A/E
subscription. This is now resolved.

Added some extra protection to the MQTT subscriber code in an attempt to prevent a rare
crash in the subscriber service.

Internet of Things Workbench Provider

Ref ID

90792

Description

When deploying the loTVisualizer module to devices using an older version of loTWorX (10.96
and any of its Critical Fix Rollups), the wrong Create Options were used. The options being
deployed were appropriate for 10.96.1 devices instead of 10.96. This may have caused the
Visualizer module to malfunction. Users experiencing these issues with the Visualizer may need
to redeploy the loTVisualizer module after updating ICONICS Suite to this version.
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KPIWorX

Ref ID
88983

89472

90811

87049

Description

Resolved an issue in the Trend widget that could prevent changes to pen connection
parameters (such as changing a pen from HDA to DA or vice versa) from taking effect.
Resolved a crash of the KPIWorX Trend widget or TrendWorX64 Viewer that would occur after
swapping the chart axes, then changing the line type (such as from line to area).

For the TrendWorX64 Viewer, the crash would occur if these properties were changed in
runtime, such as by using Commanding.
When choosing to share a widget using Image or PDF formats or sharing the entire dashboard

using PDF format, a few pixels on the right or bottom would be cut off. This has been resolved.

In the Table widget, the default format for all numeric values was incorrectly set with two
decimal places. This has been resolved. The default format is now correctly set based on the
column type so, for example, integers will show no decimal places by default. (This is always
changeable in the Table widget settings.)
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MobileHMI & HTML5 WebHMI
HTMLS5, iOS, Android

Ref ID
89072

89933

87523
87520

87155

Description

Resolved an issue that could sometimes cause global alias values to not persist upon a display
load if the alias had been set at machine level.

On HTMLS5 clients, the :ClientIPAddress Control and Diagnostics tag did not update when the
client's IP address had changed in runtime. This has been resolved.

Resolved various security issues that could occur when using a proxy server. These issues
included the security context not being correctly shared between different windows on a client
and having to login twice before the login was successful.

In many controls, such as the AlarmWorX64 Viewer, GridWorX Viewer, Recipe Grid,
BridgeWorX64 Viewer, and ReportWorX64 Viewer, runtime filters on Boolean columns did not
work (the values would remain unfiltered). This has been resolved.

3D Viewport (Tech Preview)

Ref ID
90854

Description

The Load Display command now works from the 3D Viewport.

AlarmWorX64 Viewer

Ref ID
88334

89236

89980

87483

87500

87798

86923

87123

Description

Resolved an issue where the AlarmWorX64 Viewer would incorrectly show timestamps in the
server's time zone instead of the client's.

In the unlikely event that an AlarmWorX64 Viewer was saved with an empty column filter (as
opposed to no column filter at all), the HTML5 AlarmWorX64 Viewer would incorrectly only
show rows with a null value in that column. This has been resolved - the AlarmWorX64 Viewer
now treats such filters as if there were no filter applied (which is consistent with the
desktop/WPF behavior).

An AlarmWorX64 Viewer that was hidden by default (or had an ancestor that was hidden by
default) would not display all current alarms when made visible. This has been resolved.

If an HTML5 AlarmWorX64 or GridWorX Viewer contained an expression in the configuration
file name field, the expression would only be evaluated once when the display was loaded.
Changes to the expression would not cause a new configuration file to load. This has been
resolved.

The HTML5 AlarmWorX64 Viewer now supports subscribing only to certain categories
(configured in the subscription point properties).

The HTML5 AlarmWorX64 Viewer could not load a configuration file if the file contained a style
with the beep enabled. This issue only occurred on 10.97.1 systems with Critical Fixes Rollup 1
applied and has been resolved.

When using the "grouping"” feature, the group names contained extra text. For example, when
grouping by severity, the HTML5 group names should have just used the severity number
("100", "200", etc.) but instead they had a prefix of "Priority", like "Priority 100", "Priority 200",
etc. This has been resolved.

The HTML5 AlarmWorX64 Viewer now supports the "BeepFileLocation" property, configurable
on the Advanced tab of the control (the parent item in the tree).

Asset Navigator

Ref ID
87790

Description
If the Asset Navigator had its font size changed, the magnifier and switch view buttons may not
have rendered properly in HTML5. This has been resolved.
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Data Explorer

Ref ID
87743

Description
Resolved an issue preventing the Data Explorer from displaying data when a Hyper Historian
folder was selected. This has been resolved for both desktop (WPF) and HTML5 Data Explorers.

GraphWorX64

Ref ID

88487

88756

88880

89032

89138

89264

89401

89633

89636

89646

90729

87356

87698

87904

88053

88344

88515

88533

87189

Description

Resolved an intermittent issue that could cause security-restricted layers (layers with
HideWhenSecurityDenied is set to True) to not hide when a user logged in who should have the
layer denied.

The properties of the Toggle Value pick action now support smart binding.

Resolved an issue that could cause embedded GraphWorX64 Viewers to load blank. This issue
would occur if a display loaded in the embedded viewer contained a local alias that was only
set with an initial value and then never changed. In this situation, the next display to be loaded
into the embedded viewer would not load properly and would appear as blank.

When the Set View command is applied to an embedded GraphWorX64 display, focus now gets
set to that embedded display. Previously focus could remain outside, which might prevent
keyboard shortcuts defined inside the embedded display from working.

Automatic size is now supported for popups.

Resolved an issue with StringDataSourceWithTokensAndRuntimeValue smart properties that
could prevent those smart properties from resolving.

A popup menu configured with the menu position as "MousePoint" would appear in the
bottom left corner instead of the mouse position. This has been resolved.

If there were three or more levels of clone dynamic nesting, the cloning may not have worked
properly, leading to clones that did not have data. This has been resolved.

HTML5 now supports smart symbols with smart binding on the outside of the symbol.

The WindowProperties properties of Load Display pick actions now support smart symbol
binding.

The Set Local Alias command previously ignored the TargetName parameter. This has been
resolved.

Smart binding is now supported on custom confirmation message parameters of data entry
process points.

Load Display commands within a popup menu can now use a target type of Root or Parent.

Localsim:property tags that included "GwxDynamicGroup.DynamicsList[x]" would not be
resolved in HTML5 displays. An example would be the data source of a process point, which
would look something like this:
"localsim:property:Label1.GwxDynamicGroup.DynamicsList[0].DataSource". This has been
resolved.

Selecting an edit field inside an emulated popup (popups using the "Display Dependent" or
"Display Dependent - Modal" target types) would prevent any subsequent attempts to focus on
any edit field. This has been resolved.

Color dynamics belonging to objects on a layer would stop working after the layer was hidden
and then shown if the layer was configured with the ReleaseDataWhenHidden property set to
true. This issue could also affect objects in a pivot control after the page was pivoted away and
then back. The issue has been resolved.

The WindowProperties > Text property of a Load Display command now supports smart
property binding in HTML5 displays.

Smart properties that depend on other smart properties may not work properly in HTML5
based on the order in which the properties were created. This has been resolved.

Resolved an issue that would prevent the 3D viewport from being displayed if it contained
textures serialized as nulls. This is not a common scenario, but it could occur with imported 3D
objects.

Also resolved an issue causing slow loading of global colors in a 3D viewport.
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Ref ID
87343

87481

87495

Description

When displaying the description of a dynamic object in a tooltip, line breaks were removed.
This has been resolved.

If a Write Value pick action used an IF THEN expression without any ELSE and the IF condition
was not true, a default value (such as zero) would be written. This was incorrect behavior and
has been corrected. Now if the ELSE clause is missing and the IF is not true, the write will not
occur.

The TimeDate dynamic could show an incorrect local time if the client and server were in
different time zones. This has been resolved.

GridWorX Viewer

Ref ID
88639

90183

87483

87853

86665

86685

Description
An HTML5 GridWorX Viewer configured as a scatter chart could not use dynamic values for the
Minimum and Maximum when using a specific X-range. This has been resolved.

Resolved an issue that could cause the series and axis titles with dynamic values to not resolve.

If an HTML5 AlarmWorX64 or GridWorX Viewer contained an expression in the configuration
file name field, the expression would only be evaluated once when the display was loaded.
Changes to the expression would not cause a new configuration file to load. This has been
resolved.

An HTML5 GridWorX Viewer chart could not use tags for the minimum or maximum values of
the Y axis (configured on the Chart and Axes tab of the chart). Tags in those fields were
evaluated as string constants. This has been resolved. Tags in these fields are now evaluated
and their value used to configure the Y axis.

Resolved an issue where the Y-axis title would sometimes not display if there were global
aliases or other dynamic content in the title. This issue was more likely to occur if the GridWorX
Viewer loaded a configuration file on startup, but this was not required.

Resolved an issue in HTML5 GridWorX bar charts where negative values weren't drawn as a full
bar.

ReportWorX64 Viewer

Ref ID
87082

Description
In Executor mode, the dropdown menu for list parameters used the same foreground and
background color, making it impossible to read the text. This has been resolved.

Schedule Control

Ref ID

87086

Description

In the rare event that a Schedule Control configuration file (SCHX) is missing the FontFamily
element, loading the configuration into a control would cause the display to crash and reload.
This has been resolved.

Table Control

Ref ID

87649

Description

HTMLS5 Table controls configured to use "alternate styling" for the rows would show a blank
white space after the text in columns configured with a Content Type of Hyperlink. This has
been resolved.

TrendWorX64 Viewer

Ref ID
89311

89472

Description

The TrendWorX64 Viewer did not update the pens when global aliases in the connection
parameters were updated. This has been resolved.

Resolved a crash of the KPIWorX Trend widget or TrendWorX64 Viewer that would occur after
swapping the chart axes, then changing the line type (such as from line to area).
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Ref ID

89748

89806

90070

90075

90479

90818

90925

87435

87609

87810

88324

87096

87318

87429

87602

Description

For the TrendWorX64 Viewer, the crash would occur if these properties were changed in
runtime, such as by using Commanding.

There was an issue in resolving dynamic values in TrendWorX64 Viewer command parameters
(such as parameters for the Edit Pen command) that would cause the command to fail. This has
been resolved.

Added a new property to the Advanced tab of the chart, ReadTimeRangeWhenZoomed. When
set to true, updates to the time range data source (configured on the chart's Range tab) will be
applied even when the viewer is zoomed in. When set to false, updates to the time range data
source will be paused while zoomed. The viewer will remember the last update from the time
range data source and apply it when the viewer's zoom level is reset to the default. This
property defaults to true, which is consistent with the behavior in earlier versions.

The HTML5 TrendWorX64 Viewer was not translating the name of the aggregate filter when
displaying it in the legend. This caused discrepancies between the filter names in desktop (WPF)
and HTML5 displays and could also cause interpolative filters to show as “raw data" in the
legend. This has been resolved.

When there were multiple Y axes shown, selecting a pen in the legend should move the Y axis
for that pen closest to the chart. This action would fail, resulting in the pen not being selected
at all. (The problem did not happen if the selected pen's axis was already closest to the chart.)
This has been resolved.

Added a new option for displaying cursor value. On the chart object's Cursors tab under
"Sample Selection" there is a new option named "Interpolate". When Interpolate is selected, the
cursor tooltip will display a value interpolated from the previous and next sample. (This option
is unrelated to the interpolative aggregate and can be used regardless of the pen aggregate.)
The "interpolate" sample selection option only works for area or line plots.

Note that this option will not be localized. It will appear in English, regardless of the system
language. Future versions will be properly localized.

Added a new advanced property to the chart object called AlternativeRangeAxisAreaSize. This
property acts like RangeAxisAreaSize (which sets the area available for the range axis
information to be drawn) except it applies to the side of the viewer where ranges configured
with "alternative placement" are located (usually the right side).

When the RangeAxisAreaSize property (on the Advanced tab of the chart object) was
configured with percentage values less than 10% (such as "5%"), the value would be ignored,
acting like the RangeAxisAreaSize property had a value of 0. This has been resolved.
Previously, the TrendWorX64 Viewer only drew limit lines if the pen's data source was valid.
Now the lines are drawn regardless of the data source. This is now consistent with the desktop
(WPF) TrendWorX64 Viewer.

These context menu actions, added to the desktop (WPF) TrendWorX64 Viewer in Critical Fixes
Rollup 1, can now be used in HTMLS5 displays: "Show Legend", "Show Cursors”, and "Export
Data".

When dragging a Hyper Historian process point into an HTML5 TrendWorX64 Viewer, no
history was visible. The pen was treated as a real-time (DA) tag, not historical (HDA). This has
been resolved.

The HTML5 TrendWorX64 Viewer now respects the "Grid" checkbox setting of the chart object.
Previously the grid was always shown, even if this option was disabled.

Resolved an issue that could cause manual pen ranges configured to be 0 to show as +/- 10 in
runtime.

When not enough space was available for the x-axis labels, they were not drawn at all. This has
been resolved - the labels are now trimmed with an ellipsis at the end, similar to the behavior in
the for desktop (WPF) TrendWorX64 Viewer.

Enhanced the performance of the HTML5 TrendWorX64 Viewer.

Resolved a crash in the HTML5 engine that could occur when a client triggered two or more
Edit Pen commands in sequence.

First Available In

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2
Critical Fixes
Rollup 1

Critical Fixes
Rollup 1

Critical Fixes
Rollup 1
Critical Fixes
Rollup 1



Remote Expert

Ref ID Description
Initiating a Remote Expert call would cause a 404 error on systems with an insecure (HTTP) o .
. . . - Critical Fixes
87176 origin. This issue has been resolved, but users are highly encouraged to use a secure origin Rollup 1

when configuring Remote Expert.

First Available In



Workbench

Ref ID

88505

90032

90664

87815

88042

88174

88178

88278

88545

88555

Description
Resolved an issue preventing Workbench from functioning (the Project Explorer did not load)
when this lcoCustomSetup.ini setting was configured:

[Sql]

EnableCollectionPolling=0

If the audit log was enabled, it would incorrectly show as disabled after restarting the ICONICS
Workbench Configuration Service. This was a display issue only - the audit log would be
recording as if it were enabled. This has been resolved.

Resolved a slow memory leak in GraphWorX64 and Workbench.

Resolved a very rare crash of Workbench that could occur when browsing a remote file system.
This crash would only occur in the rare situation that the user's Documents folder was not
accessible.

When running as a remote client to a redundant system, Workbench would not be able to
connect when the primary FrameWorX Server was offline. This has been resolved - Workbench
will now be able to connect to the secondary FrameWorX Server when the primary is offline.
Note, if a failure of the active server occurs while Workbench is connected, the user will need to
either restart Workbench or use the "Disconnect/Connect" button to connect to the new active
server.

Resolved a crash of Workbench that can occur when a configuration file has a certain line
duplicated. This is a rare situation, but if it does occur, Workbench now gracefully handles the
situation and no longer crashes.

When Workbench could not communicate with the ICONICS Workbench Configuration Service
or ICONICS FrameWorX Service it would show two error messages. The first message which
appeared indicated a problem communicating specifically with security and the second error
indicated a communication issue. The second error message more accurately described the
situation and included helpful troubleshooting steps. The first error was misleading and could
lead the user to think there was a problem with their security database when there was a
greater issue. Now, in the case of a communication issue, only the error message indicating a
communication issue is shown. The first error is no longer shown in this situation.

Resolved an issue in the Data Browser that appeared in 10.97.1 Critical Fixes Rollup 1 which
would cause applications such as GraphWorX64 or Workbench to hang in task manager after
they were closed if the pop-up Data Browser had been used.

Resolved a memory leak in the ICONICS Workbench Configuration Service (IcoConfigService).

The ChangePassword action of the Configure Security command did not function (the
password was not changed). This has been resolved.

Workbench Classic

Ref ID

86650

Description

Resolved an Application Download Error
(System.Deployment.Application.DeploymentDownloadException) that would occur when
opening the PubDisplay/Workbench.htm page in Internet Explorer or Edge in IE mode.

First Available In

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

New for Critical
Fixes Rollup 3

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2

Critical Fixes
Rollup 2
Critical Fixes
Rollup 2

First Available In

Critical Fixes
Rollup 1



Known Issues & Limitations

Ref ID

88327

79462

58862

88364

52673

83619

83056
63359

81025

Description

Users upgrading from a previous version to 10.97.1 who were using WCF communication ("Use WebSockets"
deselected in FrameWorX Server Location) and who installed 10.97.1 using the secure installation option (which is the
default) will see keys and be unable to use the system. There are two possible solutions to this issue. The preferred
solution is to open the FrameWorX Server Location dialog and select "Use WebSockets". If this is not a possibility,
users can re-enable WCF communication by editing a config file. This is not preferred because WCF communication
has been obsoleted by Microsoft and may be completely unavailable in future versions. Users who prefer to re-
enable WCF communication can find the steps in ICONICS Knowledgebase article KB-3852.

On Windows 7 and Server 2012 systems the ICONICS services can take an excessively long time starting (ten minutes
or more). This can delay services necessary to allow connections via Remote Desktop or Hyper-V console, meaning it
can take over ten minutes before the system can be accessed.

The workaround for this issue is to change the startup type for some services to Automatic (Delayed). Use the
Services control panel or the Configure Services dialog in Workbench to change any ICONICS service running as
Automatic to Automatic (Delayed). The ICONICS services will still be slow to become responsive, but users will be
able to remote into the system in the meantime.

The Classic BACnet trend buffer is not synchronized correctly (creating a gap in the historical trend) when the Hyper
Historian Logger Service has been stopped for a period of time (at least 15 minutes, but more likely to happen the
longer the logger has been stopped).

Systems upgraded to 10.97.1 from 10.96.2 or 10.97 may not be able to use newly added point managers. Specifically,
if this issue occurs, the point managers will not be browsable in the data browser and no clients can use their points.
These new point managers include: BACnet with SC, Mitsubishi Electric FA Connector, Hyper Alarm Logger, Hyper
Historian Query Interface, Facility AnalytiX Query Interface, loT Publisher. Users who are still using the default
configurations for their point managers will not encounter this issue.

This issue can be resolved by editing the FwxServer.PointManagers.config file. See ICONICS Knowledgebase article
KB-3860 for the steps on how to update this file.

The AlarmWorX64 Multimedia Configurator (Workbench Classic) does not support upgrading AlarmWorX64
Multimedia configurations contained in databases along with other ICONICS configurations (such as unified
configuration databases). These configurations can only be upgraded by the installation or the Configure System
utility.

Importing a CSV or XML file created in version 10.97 without any rollups applied may cause a warning if the export
file included AssetWorX equipment classes that utilize the Alarms tab of an equipment property. The warning is:

"Cannot generate the entity at location X at line Y. Unknown entity 'AlImsAcEquipmentClassPropertySourcelnput' in
the import file. If the file was manually edited it may have been edited incorrectly. If it was not edited, then the entity
may have been renamed in the software. Search the ICONICS Knowledgebase for
'‘AlmsAcEquipmentClassPropertySourcelnput' or contact technical support for assistance correcting the file with the
new entity name."

The settings on the Alarms tab of these equipment classes will not be imported.

To solve this issue, edit the CSV or XML file with a text editor and replace all instances of
"AlmsAcEquipmentClassPropertySourcelnput” with "AlmsAcEquipmentClassPropertySinput”. Once edited, such files
should be able to be imported into 10.97 systems with Critical Fixes Rollup 1 or later. Make sure to run the import
again after the file has been repaired to import the alarm settings.

Alarm acknowledgement may not succeed when acknowledging many alarms at once that originate from an
loTWorX device. Users encountering this issue can work around it by acknowledging alarms in smaller batches.

Esri maps are currently not supported in HTMLS5.

When using PowerShell cmdlets to add energy calculations to meter tags, the related AssetWorX equipment
properties (including their connection to Hyper Historian) are not automatically created. The user will have to create
these properties manually or with additional PowerShell cmdlets.
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